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BÀI 1 : CÁC QUI ƯỚC CƠ BẢN 

1.1. GIỚI THIỆU . 

1 .1 .1 . Lịch sử hình thành. 
• Bộ phần mềm Sap được bắt đầu từ các kết quả nghiên cứu phương pháp số 

(Numeric method), phương pháp phần tử hữu hạn (Finite Element Method) trong 
tính toán cơ học (Computation Mechanics) của giáo sư Edward L.Wilson 
(University of California at Berkeley,USA). 

Bảng 1-1 Các giai đoạn phát triển phần mềm SAP 

Giai đoạn 
Tên chương 

trình 
Nội dung 

1969 - 70 SAP Used Static Load to Generate 

1971-72 Solid-Sap Rewritten by Ed Wilson 

1972-73 SAP IV Subspace Iteration - Dr.Jugen Bathe 

1973-74 NON SAP New Program – The Start of ADINA 

1979-80 SAP New Linear Program for Personnal computers 

1983-1987 SAP 80 CSI added Pre and Post Processing 

1987-1990 SAP 90 Significant Modification and Documentation 

1997-Nay SAP 2000 Nonlinear Element-More Options-With Windows 
Interface 

 

• Thưở ban dầu chúng chỉ là các chương trình đơn lẻ như SolidSap…chạy trên các 
hệ thống máy tính lớn với mục đích hầu như chỉ phục vụ nghiên cứu là chính 
.Phiên bản đầu tiên của chương trình được mang tên SAP (Structural Analysis 
Program) vào năm 1970 và sau đó lần lượt xuất hiện SAP IV,SAP 80 được nâng 
cấp và hoàn thiện vào cuối những năm 80,nó là mốc đánh dấu sự xuất hiện phần 
mềm tính toán kết cấu có tính thương mại đầu tiên của họ.SAP được phát triển bởi 
công ty COMPUTER AND STRUCTURE INC (CSI).SAP 2000 là một bước đột 
phá của họ.Phần mềm SAP 2000 theo hãng CSI tuyên bố là cộng nghệ ngày nay 
cho tương lai. 
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• Ngoài khả năng phân tích được những bài toán thương gặp của kết cấu công 
trình,version SAP 2000 đã bổ sung thêm các loại phần tử mẫu và tính năng phân 
tích kết cấu phi tuyến.Giao diện của nó với người sử dụng trở nên thân thiện hơn 
rất nhiều,do chương trình được thiết kế làm việc hoàn toàn trên môi trường 
WINDOWS. 

1.1.2. Mô hình hóa – khả năng của SAP 2000. 
• Sử dụng phương pháp phần tử hữu hạn để mô hình hóa và phân tích kết cấu. 

• Sap 2000 cung cấp nhiều tính năng mạnh để mô tả lớp các bài toán kết cấu phổ 
biến trong thực tế kĩ thuật,chúng bao gồm : Cầu,đập chắn,bồn chứa,các tòa 
nhà…Các giao tiếp đồ họa dựa trên các cửa sổ,cho phép nhanh chóng tạo ra các 
mô hình kết cấu từ các mẫu thư viện sẵn có.Tất cả việc chỉnh sửa,thay đổi..phân 
tích nội lực cũng như biểu diễn và thiết kế đều được thực hiện cùng một cách 
giống nhau.Người sử dụng hoàn toàn có thể thao tác trực tiếp trên các hình ảnh đồ 
họa hai,ba chiều (2D,3D). 

• Các phần tử mẫu gồm có : thanh dàn,dầm (Frame/Struss),tấm vỏ -màng 
(Shell/plate),phần tử 2 chiều-ứng suất phẳng biến dang phẳng,đối xứng 
trục(plane/asolid),phần tử khối (solid) cho tới phần tử phi tuyến (Nlink) 

• Vật liệu có thể tuyến tính (linear) đẳng hướng hoặc trực hướng và phi tuyến. 

• Các liên kết bao gồm có : liên kết cứng,liên kết đàn hồi,liên kết cục bộ khử bớt các 
thành phần phản lực. 

• Đa hệ toạn độ : có thể dung nhiều hệ tọa độ để mô hình hóa từng phần của kết 
cấu.Nhiều cách thức rang buộc các phần khác nhau của kết cấu. 

• Tải trọng bao gồm lực tập trung tại nút,áp lực lên phần tử,ảnh hưởng của nhiệt 
độ,tải trọng theo phổ gia tốc,tải trọng điều hòa và tải trọng di động…..Chúng có 
thể đặt tại nút,hoặc phân bố đều,hình thang,tập trung và áp lực t rên phần tử … 

• Khả năng giải các bài toán lớn không hạn chế số ẩn số,giải thuật ổn định và hiệu 
suất cao. 

• Các phân tích cho bài toán kết cấu bao gồm : 
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Hình 1-1 Các khả năng phân tích của SAP 2000 

• Các phương án tải có thể kết hợp với nhau.Một kết cấu có thể có nhiều loại phần 
tử mẫu. 

• Khả năng thiết kế chi tiết cho vật liệu BTCT; kết cấu thép;kết cấu nhôm theo 
nhiều tiêu chuẩn của các nước tiến tiến. 

• Tiêu chuẩn thiết kế bê tong cốt thép : 

• US ACI 318-05/IBC 2003 : tiêu chuẩn của viện bê tong Mỹ(ACI) 

• Canadian CSA-A23.3-04 (2004) Tiêu chuẩn Canada 

• British BS 8110-97 Tiêu chuẩn Anh 

• Eurocode 2 -2004 Tiêu chuẩn châu Âu 

• AS 3600 01 Tiêu chuẩn của Australia 

• New Zealand NZS 3101-95 

• ….. 

• Tiêu chuẩn thiết kế kết cấu thép  

• US AISC/ASD 01,AISD/LFRD 99, 

• Canadian CAN/CSA-S16.1-01 

• British BS 5950 1990 

• Eurocode 3 -2005 

• …… 
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1.1.3. Các fi le dữ liệu : 
• *.SDB : file dữ liệu chính. 

• *.s2k : File dữ liệu dưới dạng text;có thể dung các trình soạn thảo văn vản để xem 
và điều chỉnh. 

1.2. Các bước cơ bản để thực hiện t ính toán và phân t ích kết  cấu bằng các 
phần mềm SAP 2000. 

1.2.1. Xây dựng và điều chỉnh hình học 

1.2.2. Định nghĩa vật liệu,tiết diện và gán chi tiết cho các phần tử 

1.2.3. Điều chỉnh gối tựa. 

1.2.4. Định nghĩa các phương án chất tải và gán chi tiết. 
1.2.5. Định nghĩa các thanh đặc biết nếu có  

Ví dụ thanh khớp,thanh nhịp thong thủy,quay tiết diện,số mặt tính toán… 

1.2.6. Định nghĩa các phương án tổ hợp. 

1.2.7. Định nghĩa các phương án phân tích 

1.2.8. Chạy và phân tích sơ bộ công tr ình theo qui phạm 
 Về nội lực và độ cứng nếu đạt yêu cầu chuyển sang bước 9 ,nếu không đạt thì quay lại 

các bước (1 ÷8) để điều chỉnh. 

1.2.9. Thiết kế theo vật liệu (BTCT hoặc Thép ) 
 Phân tích theo tiêu chí vật liệu nếu không đạt quay lại các bước (1 ÷8) để điều chỉnh. 

1.3. Một  số qui định cơ bản. 

1 .3 .1 . Hệ đơn vị cơ bản dung tr ong công tr ình  SAP 2000 sử dụng 
Có 2 hệ đơn vị trong SAP 2000 : English và Metric.Một hệ đơn vị bao gồm đơn vị 

lực,chiều dài,nhiệt độ và thời gian. 

• Lực (lbs, kip, N, kN, etc.),  

• Chiều dài (ft, in, m, mm, etc.),  

• Thời gian (second),  

• Nhiệt độ (F, C) 
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1.3.2. Đơn vị góc đo độ dùng tr ong SAP 2000. 
 Gồm độ (o) và radian : 

• Độ (o) được sử dụng để chỉ định thông số hình học chẳng hạn như góc của trục địa 
phương. 

• Radian dùng để chỉ định góc xoay của chuyển vị. 

• Kết quả góc xoay xuất ra sử dụng đơn vị radian. 
Bạn có thể thay đổi đơn vị hiện tại bất kì lúc nào bằng cách click hộp xổ xuống ở bên 

phải thanh trạng thái. 

1.3.3. Nút (node). 
Nút được hiểu là một vị trí dung để xác định các kích thước hình học cơ bản của kết 

cấu.Mỗi nút được xác định thong qua tên nút và tọa độ của nó trong hệ tọa độ chung 
.SAP 2000 tự động đánh số các nút của mô hình.Các dữ liệu của nút thường là : tên (Joint 
Label),tọa độ (Coordinate),hệ toạn độ địa phương của nút,tải trọng nút (Joint Load),liên 
kết khống kế chuyển vị nút (Restraint),liên kết đàn hồi (Springs),chuyển vị cưỡng bức 
của nút… 

1.3.4. Phần tử (Element). 
Là các thành phần khác nhau của kết cấu được xác định thong qua các điểm nút.Mỗi 

phần tử có một giá trị số đại diện cho tên phần tử và được xác định thong qua các điểm 
nút.Mỗi phần tử có một giá trị số đại diện cho tên phần tử và được xác định thong qua 2 
hoặc nhiều nút tùy loại phần tử.Ví dụ phần tử frame(thanh)xác định thong qua 2 hoặc 
phần tử shell (vỏ,tấm)xác định thông qua 3 hoặc 4,8, hoặc 9 nút. 
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Các dữ liệu của phần tử : tên,nút biên của phần tử,hệ tọa độ địa phuonwg,vật liệu phần 
tử,các đặc tính mặt cắt phần tử,tải trọng tác dụng lên phần tử ,… 

1.3.5. Hệ tọa độ (Coor dinate system) 

a. Hệ tọa độ tổng thể (Global coordinate system) 
• Hệ tọa độ tổng thể là hệ tọa độ vuông góc 

trong không gian ba chiều,các trục tọa độ 
vuông góc với nhau và hợp thành một tam 
diện thuận,chiều của chúng được xác định 
bằng quy tắc bàn tay phải.Các trục của hệ 
tọa độ tổng thể được quy ước là các trục 
X,Y,Z trong SAP 2000 hệ tọa độ này có tên 
là GLOBAL 

• Hướng mặc định của hệ trục tọa độ luôn có 
chiều dương của trục Z hướng thẳng đứng từ 

dưới lên trên.Các hệ trục tọa độ địa phương 
cho nút,phần tử và tải trọng của gia tốc nền 
đều được định nghĩa tương ứng với hướng thẳng đứng này.Riêng đối với tải trọng 
bản thân được định nghĩa theo chiều ngược với trục Z mặt phẳng X-Y nằm ngang. 

• Hệ tọa độ tổng thể có thể là hệ tọa độ vuông góc (Cartesian) và hệ tọa độ trụ 
(Cylindrical) 

 

Hình 1-3 Mặt bằng lưới của hệ tọa độ vuông góc và hệ tọa độ trụ. 

Hình 1-2 Hệ tọa độ tổng thể. 
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b. Định nghĩa hệ trục tọa độ bổ sung. 
Hệ trục tọa độ bổ sung có thể được dùng  để dễ dàng cho quá trình mô hình một bộ phận 

nào đó của kết cấu.Một hệ trục tọa độ phải có một điểm gốc và các trục,các trục này 
vuông góc với nhau và xác định theo quy tắc bàn tay phải. 

• Define > Coordinate Systems/Grids…>Add New System. 
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Hình 1-4 Góc xoay dương của hệ tọa độ mới. 

c. Hệ tọa độ địa phương. 
Mỗi thành phần cơ bản của kết cấu (nút,phần tử ,hay ràng buộc chuyển vị) đều có các hệ 

tọa độ địa phương của chính nó.Các trục của hệ tọa độ địa phương cũng được xác định 
bằng quy tắc bàn tay phải và kí hiệu các trục 1,2,3.Để tạo hệ trục này ta dung chức năng 
tạo hệ tọa độ địa phương của của SAP 2000 

Trục 1 màu đỏ,trục 2 màu trắng và trục 3 màu xanh giống như màu của quốc kì Mĩ. 

 

Hình 1-5 Trục tọa độ địa phương của phần tử thanh. 
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Hình 1-6 Trục tọa độ địa phương của phần tử tấm. 
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1.3.6. Nguyên tắc bàn phải. 

 

Hình 1-7 Nguyên tắc bàn tay phải. 

1.3.7. Bậc tự do của nút (DOF – Degr ee of Fr eedom) 
• Sự biến dạng của kết cấu khi chịu tác dụng của ngoại lực,được biểu diễn qua sự 

chuyển vị của các nút.Đối với kết cấu không gian (3-D) trong trường hợp tổng 
quát một số nút có sáu thành phần chuyển vị của nó. 

• Bậc tự do của một nút tương ứng với một số thành phần chuyển vị của một nút 
gồm có : tọa độ riêng (U1,U2,U3). 
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• 3 thành phần chuyển vị xoay quanh 3 trục 1,2,3 của hệ tọa độ riêng (R1,R2,R3) 

• Một số thành phần chuyển vị có hai trạng thái : có thể có chuyển vị hay bị không 
chế chuyển vị.Đối với các phần tử mẫu tương ứng với các mô hình phân tích khác 
nhau thì số thành phần chuyển vị của một nút tương ứng cũng khác nhau,nó tùy 
thuộc vào sự làm việc của phần tử đó.Số thành phần chuyển vị của một nút được 
gọi là bậc tự do(degree of freedom –DOF) của nút. 

• Mặc định hướng của các trục 1,2,3 của một nút sẽ song song với hướng của các 
trục X,Y,Z. 

1.3.8. Liên kết  (Restra ints) 
Là điều kiện liên kết với trái đất của một nút.Sap 2000 dùng nhiều loại liên kết như gối 

tựa,khớp cố định,ngàm,liên kết hồi. 

1.3.9. Tải  tr ọng (Load) : 
-Trường hợp tải trọng (Load case) : Trong SAP 2000 cho phép khai báo nhiều trường 

hợp tải trọng,file kết quả SAP 2000 đưa ra chứa nội lực,chuyển vị của từng trường hợp 
tải. 

-Tổ hợp tải trọng (Load Combination): Người dùng có thể chỉ định sự có mặt cùng lúc 
của nhiều trường hợp tải gây ra kết quả bất lợi nhất cho kết cấu.Khi đó SAP 2000 đưa ra 
kết quả là tổ hợp tuyến tính theo nguyên lý cộng tác dụng(Add) hoặc theo kiểu đường 
bao. 
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BÀI 2 : CÔNG CỤ XÂY DỰNG HÌNH HỌC 

2.1. Màn hình làm việc cơ bản của SAP 2000. 
Trong SAP 2000 ,việc thực hiện một số thao tác lệnh thường thông qua thanh công cụ 

chứa các biểu tượng tương ứng.Dưới đây là một số biểu tượng thường được sử dụng 
trong SAP 2000. 

 

Hình 2-1 Cửa sổ làm việc của SAP 2000 

2.2. Tính năng và tác dụng của các icon trong SAP 2000. 
Icon Tên Icon Shortkey Tính năng và tác dụng 

 
New Model Ctrl + N Tạo mô hình mới 

 
Open .SDB Ctrl + O Mở file SDB 

 
Save Model Ctrl + S Lưu mô hình 
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Print Graphic Ctrl + G In hình ảnh 

 
Undo Ctrl + Z Hủy một lệnh trước đó 

 Redo Ctrl + Y Hủy một lệnh sau đó 

 Refresh Window Ctrl + W Làm mới cửa sổ 

 Lock Model  Khóa mô hình 

 Run Analysis F5 Chạy phân tích mô hình 

 
Model –Alive  Tự động cập nhật phân tích khi 

mô hình thay đổi 

 Rubber Zoom Band F2 Phóng to một vùng kết cấu 

 Restore Full View F3 Xem đầy đủ mô hình kết cấu 

 Previous View  Xem kết cấu trước đó 

 
Zoom In Step One Shift + 

F8 
Phóng to từng bước 

 
Zoom Out Step One Shift + 

F9 
Thu nhỏ từng bước 

 

Pan F8 
(Middle 
Mouse) 

Di chuyển màn hình 

 
Set Default 3D 
View 

 Xem mô hình 3D mặc định 

 
Set XY View  Xem mô hình trong mặt phẳng 

XY 

 
Set XZ View  Xem mô hình trong mạt phẳng 

XZ 

 Set YZ View  Xem mô hình trong mạt phẳng 
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YZ 

 Set Named View  Xem mặt cắt nâng cao 

 Perspective Toggle  Đổi sang phép chiếu phối cảnh 

 
Move Up In List  Di chuyển đến mặt phẳng cao 

hơn 

 
Move Down In List  Di chuyển đến mặt phẳng thấp 

hơn 

 
Object Shrink 
Toggle 

 Bật/tắt chế độ rút ngắn đối 
tượng 

 Set Display Options Ctrl + E Thiết lập lựa chọn hiển thị 

 Assign to Group  Tạo Group 

 
Show Undeformed 
Shape 

F4 Hiển thị mô hình chưa biến 
dạng 

 
Show Deformed 
Shape 

F6 Hiển thị mô hình biến dạng 

 
Show 
Forces/Stresses 

 Hiển thị nội lực/ứng suất 

 

Show Named 
Display 

 Hiển thị các hình đã lưu tên kết 
hợp với Display > Save Named 
Display 

 

Start Steel 
Design/Check of 
Structure 

 Chạy thiết kế thép hoặc kiểm tra 
kết cấu 

 

Start Concrete 
Design/Check of 
Structure 

 Chạy thiết kế bê tông cốt thép 
hoặc kiểm tra kết cấu. 

 Set Select Mode  Chuyển sang chế độ chọn 
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Set Reshape 
Element Mode 

 Sửa đổi hình dạng phần tử 

 Draw Special Point  Vẽ điểm đặc biệt 

 
Draw Frame/Cable 
Element 

 Vẽ thanh/cáp 

 

Quick Draw 
Frame/Cable 
Element 

 Vẽ nhanh thanh/cáp 

 Quick Draw Braces  Vẽ nhanh giằng 

 
Quick Draw 
Secondary Beam 

 Vẽ nhanh dầm phụ 

 Draw Poly Area  Vẽ tấm 

 
Draw Rectangular 
Area Element 

 Vẽ tấm chữ nhật 

 
Quick Draw Area 
Element 

 Vẽ nhanh phần tử tấm 

 Draw Solid  Vẽ khối 

 Select All Ctrl + A Chọn toàn bộ mô hình 

 
Get Previous 
Selection 

 Chọn phần tử lúc trước đã chọn 

 Clear Selection  Bỏ chọn các đối tượng 

 
Point and Grid 
Intersection 

 Bắt điểm tại nút và giao các lưới 

 
End and Midpoint  Bắt điểm đầu ,điểm cuối và 

trung điểm phần tử thanh/cáp 

 
Perpendicular 
Projection 

 Bắt điểm là chân vuông góc với 
thanh 
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Lines and Edges  Bắt điểm thuộc thanh /cáp hoặc 

biên của tấm/khối. 

 

 

Hình 2-2 Hộp thoại Display Options For Active Window 

Một số biểu tượng cơ bản của SAP 2000 V14 



SAP 200 V14.0.0 – Công cụ cơ bản 

Ks.Lê Văn Duy SĐT : 0916028581 

Trung tâm đồ họa Hoàng Nhi.                                                                                       19 

BÀI 3 : HỆ THỐNG KẾT CẤU MẪU. 
File >New Model>Chọn các mẫu tương ứng  

 

Hình 3-1 Cửa sổ New Model 

• Tùy theo các công trình cụ thể,chúng ta chọn mẫu kết cấu tương ứng 

• Trong mỗi loại sẽ có các hướng dẫn cụ thể hoặc các mẫu cụ thể hơn nữa với các 
hình vẽ mô tả các loại kích thước cần vào 

3.1.1. Hệ thống lưới định vị : Gr id Only 
Khi đó sẽ xuất hiện bảng định nghĩa lưới,dựa vào công trình cụ thể ta định nghĩa lưới 
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Hình 3-2 Cửa sổ Quick Grid Lines 

• Chọn một trong 2 tọa độ, với công trình có các góc vuông thường sử dụng hệ tọa 
độ (Cartesian) khi đó phải định nghĩa các thông số sau : 

• Number of Grid Line : Tổng số lưới theo các phương (X,Y,Z) thông thường ta dựa 
vào các trục kết cấu để định nghĩa lưới 

• Grid Spacing : Khoảng cách của lưới theo các phương 

• First Grid Line Location : vị trí của lưới đầu tiên. 

• Nhấn OK. 

• Menu Define > Coordinate Systems/Grids… để sửa chi tiết. 
Hoặc click chuột phải vào cửa sổ làm việc chọn Edit Grid Data hoặc Click vào bất kì 

Grid line nào 
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Hình 3-3 Sửa chi tiết lưới 

• Click Modify/Show System. 

 

Hình 3-4 Cửa sổ Coordinate/Grid Systems 
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Hình 3-5 Cửa sổ Define Grid System Data 

• Units : chọn hệ đơn vị 

• Display Grid as : Xác định cách hiển thị lưới 
o  Ordinate : Hiển thị lưới theo hệ trục tổng thể 
o Spacings : Hiển thị theo khoảng cách giữa các đường lưới. 

• Hide All Grid Lines : ẩn các đường lưới. 

• Glue to Grid Line : Dính các nút vào lưới ; điều chỉnh lưới cũng có nghĩa là điều 
chỉnh hệ trục kết cấu 

• Buble size : Kích thước vòng tròn hiển thị trục 

• Reset to default color : đưa về chế độ màu chuẩn,mặc định. 

• Reorder Ordinate : Sắp xếp lại thứ tự tọa độ đường lưới 
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• Trong quá trình điều chỉnh có thể vào Menu Edit để thêm xóa các đường lưới 

3.1.2. Hệ dầm l iên tục Beam. 
Với hệ dầm liên tục cần đưa ra các thông tin sau :  

 

Hình 3-6 Cửa sổ khai báo Beam 

• Number of Spans : Tổng số nhịp 

• Span length : Khoảng cách của một nhịp 

• Section Properties : Chọn tiết diện sơ bộ cho dầm.Có thể click vào Nút dấu + để 
khai báo luôn tiết diện. 

• Nhấn Ok 

 

Hình 3-7 Mô hình Beam. 

3.1.3. Hệ khung phẳng 2D Frame : 
BÀI 1 : Với hệ khung phẳng cần đưa ra các thông tin sau : 
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Hình 3-8 Cửa sổ khai báo 2D Frames 

• Number of Stories : Tổng số tầng 

• Number of Bays : Tổng số nhịp theo phương X 

• Story Height : chiều cao tầng 

• Bay Width : Chiều rộng một nhịp 

• Beams : Chọn tiết diện sơ bộ cho dầm 

• Columns : Chọn tiết diện sơ bộ cho cột 
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3.1.4. Hệ khung không gian 3D frame. 

 

Hình 3-9 Open Frame Building 

Với hệ Open Frame Building : hệ thanh chưa có sàn 

• Number of Stories : Tổng số tầng 

• Number of Bays X : tổng số nhịp theo phương X 

• Number of Bays Y : tổng số nhịp theo phương Y 

• Story Height : Chiều cao tầng 

• Bay Width X : Chiều rộng một nhịp X 

• Bay Width Y : Chiều rộng nhịp Y 

• Beams : Chọn tiết diện sơ bộ cho dầm 

• Columns : Chọn tiết diện sơ bộ cho cột 
Với hệ Beam-Slab Building : Hệ không gian có sàn. 
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Hình 3-10 Beam - Slab Building 

• Number of Stories : Tổng số tầng 

• Number of Bays X : Tổng số nhịp theo phương X 

• Number of Báy Y : Tổng số nhịp theo phương Y 

• Story Height : Chiều cao tầng 

• Bay Width X : Chiều rộng một nhịp X 

• Bay Width Y : Chiều rộng một nhịp Y 

• Number of Division X : Số lưới chia nhỏ tự động tấm sàn theo X 

• Number of Division Y : Số lưới chia nhỏ tự động tấm sàn theo Y 

• Beams : chọn tiết diện sơ bộ cho dầm 

• Columns : Chọn tiết diện sơ bộ cho sàn 

• Area : chọn tiết diện sơ bộ cho sàn. 
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3.1.5. Hệ dàn phẳng (2D Tr uss) : 

 

Hình 3-11 2D Truss 

• Number of Divisions : Số bước mắt dàn 

• Division Length : Chiều dài một bước mắt dàn. 

• Height : Chiều cao của dàn 

• Ngoài ra muốn chọn các loại dàn khác nhau chọn 2D Truss Type vào Parametric 
Definition để xem ý nghĩa các ký hiệu. 

 

Hình 3-12 Cấu tạo dàn 
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Hình 3-13 Các loại dàn thường gặp 
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3.1.6. Hệ tường vách phẳng (Wall ). 

 

Hình 3-14 Khai báo hệ Wall 

• Number of Divisions X : Số đoạn chia của vách theo phương X 

• Number of Division Y : Số đoạn chia của vách theo phương Y 

• Division Width X : Độ dài đoạn chia theo X 

• Division Width Y : Độ dài đoạn chia theo Y 

• Section : Chọn độ dày của tấm vách 
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3.1.7. Hệ kết  cấu sàn phẳng (Flat Slab) : 

 

Hình 3-15 Một số loại sàn khác nhau 
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Hình 3-16 Sàn đặt trực tiếp lên cột 

 

Hình 3-17 Sàn phẳng có panel 
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Hình 3-18 Sàn phẳng có mũ cột 

 

Hình 3-19 Khai báo hệ Slab 

• Number of Division X : Số đoạn chia của sàn theo phương X 

• Number of Division Y : Số đoạn chia của sàn theo phương Y 

• Division Width X : Độ dài đoạn chia theo X 

• Division Width Y : Độ dài đoạn chia theo Y 

• Middle Strip Width X : Độ rộng của dải giữa nhịp theo X 

• Middle Strip Width Y : Độ rộng của dải giữa nhịp theo Y 
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• Section : Chọn tiết diện của tấm sàn 

3.1.8. Hệ kết  cấu thanh dàn không gian (3D Tr uses) 

 

Hình 3-20 3D Trusses 

• Muốn chọn các loại dàn khác nhau chọn 3D Truss type; vào Parametric definition 
để xem ý nghĩa các ký hiệu. 

Ngoài ra Sap 2000 V14 còn có nhiều bài toán khảo sát chuyên dụng như kết cấu thang; 
các tháp silo; các loại liên kết…. 
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3.1.9. Hệ tấm vỏ Shells. 

 

Hình 3-21 Shells. 

Chọn Barrel Shell : 

 

Hình 3-22 Barrel Shell. 

• Nhấn Parametric Definition để xem các định nghĩa thông số. 
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Ví dụ : 
Hầm dài L=10m 
Mặt cắt ngang hầm : 

4000

2
5
0
0

1
2
0
0

3
7
0
0

 

Hình 3-23 Mặt cắt ngang hầm. 

Hướng dẫn giải : 
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Hình 3-24 Lời giải bài toán vòm. 

3.1.10. Cầu thang StairCase. 

 

Hình 3-25 Staircases. 

• Chọn Staircase Type 2 là cầu thang phổ biến nhất 

• Click Parametric Definition để xem các thông số định nghĩa. 
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BÀI 4 : ĐỊNH NGHĨA VẬT LIỆU-TIẾT DIỆN-GÁN CHI TIẾT 
CHO ĐỐI TƯỢNG. 

4.1. Định nghĩa các loại vật liệu : 
Mỗi một công trình có thể sử dụng một hoặc nhiều loại vật liệu.Để định nghĩa một loại 

vật liệu làm như sau : 
Vào Define > Material > Add New 

Material 
• Add New Material Quick : 

Thêm một loại vật liệu trong 
danh sách sẵn có.Chủ yếu là 
các vật liệu theo tiêu chuẩn 
nước ngoài. 

• Add New Material :Thêm một 
loại vật liệu. 

• Add Copy of Material : Thêm 
một vật liệu mới có các thuộc 
tính tương tự vật liệu có sẵn. 

• Modify/Show Material : Thay 
đổi loại vật liệu có sẵn( đã khai báo) 

o Chọn tên vật liệu 
o Bấm vào Modify à  Giống như New 

• Delete : chỉ xóa được khi chưa gán vật liệu cho tiết diện 
o Material Name and Display color: Tên loại vật liệu và màu sắc vật liệu.Tên 

vật liệu do người dùng đặt nên đặt tên theo vật liệu sử dụng.Ví dụ : B25 
o Material Type : Dạng vật liệu 
o Weight per Unit volume : Trọng lượng riêng 
o Modulus of  Elasticity : Mô đun đàn hồi E tra bảng TCXDVN 356 : 2005. 
o Poison’s Ratio : Hệ số Poison .Bê tông =0.18÷0.2,Thép =0.3 
o Coeffcient  of Thermal Expansion : Hệ số dãn nở nhiệt  
o Shear Modulus : Mô đun kháng cắt được tính từ E và hệ số Poison 

( )2 1

E
G

υ
=

+
 

o Specified Concrete compressive Strength, f’c : Cường độ chịu nén đặc 
trưng của bê tông. 

Hình 4-1 Define Materials 
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Hình 4-2Cửa sổ Add New và Modify/Show Material 

 
 
 

Hình 4-3 Một số cấp độ bền bê tông thường gặp. 
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Hình 4-4 Môđun đàn hồi ban đầu của một số bê tông. 

4.2. Định nghĩa các loại tiết diện thanh – gán chi tiết cho phần tử thanh. 
Trong một công trình có dùng nhiều loại tiết diện.Trước khi gán chúng ta phải định 

nghĩa. 

 

Hình 4-5 Một số tiết diện thường gặp 
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Vào Define > Section Properties > Frame Section. 
Nhấn Add New Properties 

 

4.2.1. Định nghĩa tiết diện bê tông hình chữ nhật 
• Chọn Add New Property. 

• Frame Section Property Type : chọn Concrete 

• Chọn Rectangular 
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Hình 4-6 Add Frame Section Property 

 

Hình 4-7 Rectangular Section 
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Nhấn Concrete Reinforcement để điều chỉnh lớp bê tông bảo vệ và  bố trí cốt thép 
mềm cho cột. 

 

Hình 4-8 Reinforcement Data. 
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Hình 4-9 Bố trí cốt thép của một số cột 

4.2.2. Định nghĩa một số đường kính cây cốt thép (Reinforcement Bar Size). 
• Define > Section Properties > Reinforcement Bar Size… 
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• Một số loại thép trong SAP 2000 : 

 
• Khai báo tên thép,diện tích cây thép và đường kính thép.Nhấn Add rồi Ok. 

4.2.3. Gán ti ết diện vừa định nghĩa cho phần tử. 
• Bước 1 : Chọn phần tử cần gán tiết diện 

• Bước 2 : Assign > Frame > Frame Sections… 

 

4.2.4. Định nghĩa tiết diện cột có hình dạng phức tạp bằng Section Designer 
• Define > Section Properties > Frame Section… 
• Add New Properties…. 
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• Chọn Section Designer 
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Hình 4-10 SD Section Data. 

• Chọn Section Designer… 
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Hình 4-11 CSISD 

4.2.5. Phần tử Frame có tiết diện NonPrismatic 
Kiểu phần tử có tiết diện đều theo trục thanh : phải khai báo ít nhất hai loại tiết diện trở 

lên.  
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Hình 4-12 Ví dụ thanh Nonprismatic 
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Hình 4-13 Add Frame Section Property 

• Frame Section Property Type chọn Other 

• Chọn Nonprismatic 

 

Hình 4-14 Nonprismatic Section Name 
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o Chọn Start Section 
o Chọn End Section 
o Nhập Length : Chiều dài đoạn section 
o Length Type : chọn kiểu tính chiều dài : Variable ( chiều dài tương đối) 

Absolute (giá trị chiều dài) 

Bảng 4-1 Khai báo cho dầm thép chữ I 

 

Bảng 4-2 Khai báo cho cột bê tông có mũ cột 

 
o EI33 Variation : Kiểu thay đổi EI33 
o EI22 Variation : Kiểu thay đổi EI22 

 
o Add,Insert,Modify,Delete : Thêm,chèn,Chỉnh sửa,Xóa 
o Ok 

4.2.6. Phần tử Frame tiết diện General. 
• Phần tử mà kiểu tiết diện không có trong các kiểu của Sap,phải tính các đặc trưng 

hình học I; mô men quán tính J ; mô men xoắn 

• Thường dùng trong bài tập cơ học kết cấu,kết cấu mà tiết diện là tổ hợp của nhiều 
tiết diện cơ bản.Tính kết cấu không quan tâm đến chuyển vị cũng có thể dùng. 
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• Chọn General 

 
o Cross-section (axial) area : Diện tích tiết diện A 
o Torsional  constant : Mô men quán tính chống xoắn J 
o Moment of Inertia about 3 axis : Mô men quán tính quay xung quanh trục 3 
o Moment of Inertia about 2 axis : Mô men quán tính quay xung quanh trục 2 
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o Shear Area : Diện tích cắt As. 

 

Hình 4-15 Công thức tính Shear Area 
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o Section Modulus About 3(2) Axis : Mô men chống uốn 
ax

W ;
m

I

y
= Với hình 

chữ nhật 
2

W
6

bh=  

o Plastic Modulus About 3(2) Axis : Mô men dẻo 
W

1.3
W =  

o Radius of Gyration About 3(2) : bán kính quán tỉnh 2 I
r

A
=  

o Ok à  Ra màn hình khai báo tiết diện 
o Material Name 
o Chọn Material 
o Ok 

4.2.7. Phần tử Frame có tiết diện Auto Select : 
• Nhóm các tiết diện đã có vào một nhóm.Kiểu nhóm này gọi là Autoselect 

• Auto Select Section Lists are used in Steel Frame, Aluminum Frame, and Cold-
Formed Steel Frame design 

• Khai báo : Ít nhất phải có hai loại tiết diện : 
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o Click Auto Select List 
o Chọn các section đã khai báo đưa vào danh sách của Auto Select. 
o Add Remove 
o Ok 

• Chú ý :SAP 2000 lấy độ cứng trung bình của các loại tiết diện trong Auto Select 

khi xác định nội lực. 
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4.3. Định nghĩa các loại tiết diện tấm – gán chi tiết cho phần tử tấm. 

 

4.3.1. Định nghĩa tấm 
• Define > Area Section > Add New 

Section 
o Section Name : Tên tiết diện 

tấm 
o Type : Thường chọn Shell-

thin : tấm tổng quát-dạng 
mỏng( có đầy đủ các thành 
phần nội lực) 

§ Plate Thick (a/h < 
8..10) 

§ Membrane(a/h > 
=80..100) 

§ Plate-thin : còn lại 
o Material : Vật liệu 
o Thickness : Độ dày 

§ Membrane = bending 
: cùng độ dầy khi 
uốn và kéo nén 

• Ok 

4.3.2. Gán ti ết diện vừa định nghĩa 
cho phần tử tấm : 

• Bước 1 : Chọn phần tử cần gán tiết 
diện 

• Bước 2 : Assign > Area > Section 
> Nhấn vào tên tiết diện cần 
gán.Kết quả tên của tiết diện hiện 
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trên tấm tương ứng. 

4.4. Vẽ dầm,cột và sàn. 

4.4.1. Vẽ dầm. 

• Click  để chọn vẽ  trên mặt bằng. 

• Click mũi tên lên hoặc xuống  để đi đến tầng muốn vẽ. 

• Click  Quick Draw Frame/Cable Element để vẽ nhanh dầm. 

• Chọn tiết diện mong muốn. 

 

Hình 4-16 Chọn tiết diện muốn vẽ. 

• Quét cửa sổ bao quanh ô lưới hoặc click trực tiếp lên lưới. 
Để kết thúc vẽ một đối tượng thanh bạn có thể click đúp vào điểm cuối hoặc click điểm 

cuối sau đó nhấn Enter hoặc nhấn phim ESC. 

4.4.2. Vẽ cột .  

• Click  chọn xz (yz) để chọn vẽ trên mặt cắt song song mặt phẳng 
Oxz(Oyz). 

• Click mũi tên lên hoặc xuống  để đi đến mặt cắt muốn vẽ. 

• Click  Quick Draw Frame/Cable Element để vẽ nhanh cột. 

• Chọn tiết diện mong muốn. 

 

Hình 4-17 Chọn tiết diện muốn vẽ. 

• Quét cửa sổ bao quanh ô lưới hoặc click trực tiếp lên lưới. 
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4.4.3. Vẽ sàn hoặc vách. 

• Click  để chọn vẽ  sàn trên mặt bằng và  để vẽ vách trên mặt cắt. 

• Click mũi tên lên hoặc xuống  để đi đến mặt bằng(mặt cắt) muốn vẽ. 

a. Vẽ nhanh sàn. 

• Click Quick Draw Area Element để vẽ nhanh sàn(vách). 

• Chọn tiết diện sàn (vách)mong muốn. 

 

Hình 4-18 Chọn tiết diện tấm mong muốn. 

• Quét cửa sổ bao quanh ô lưới nếu vẽ nhiều ô sàn hoặc click trực tiếp vào ô lưới 
nếu vẽ một ô sàn. 

b. Vẽ sàn hình chữ nhật. 

• Click  Draw Rectangular Area để vẽ sàn (vách) hình chữ nhật. 

• Chọn tiết diện sàn (vách)mong muốn. 

 

Hình 4-19 Chọn tiết diện tấm mong muốn. 

• Pick điểm đầu rồi điểm cuối 

c. Vẽ sàn hình đa giác. 

• Click  Draw Poly Area để vẽ sàn(vách). 

• Chọn tiết diện sàn (vách)mong muốn. 

 

Hình 4-20 Chọn tiết diện tấm mong muốn. 
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• Pick lần lượt các đỉnh của sàn ngược chiều kim đồng hồ để đảm bảo trục 3 của sàn 
hướng lên trên. 

Khi kết thúc vẽ tâm bạn click đúp hoặc click vào điểm cuối rồi nhấn Enter. 

• Lưu ý :  Chỉ nên vẽ tấm sàn hình tam giác hoặc tứ giác.Ngược lại sẽ dẫn đến chia 

tấm và truyền tải bị sai. 

d. Xem tấm hoặc khối. 

• Để xem phần tử tấm hoặc solid click  hoặc View > Set Display Options… 

 

Hình 4-21 Hộp thoại Display Options For Active Windows. 

4.5. Copy toàn bộ dầm,sàn từ tầng này sang tầng khác. 

• Click  Set Select Mode để chuyển từ chế độ vẽ sang chế độ chọn. 

• Edit > Replicate… 
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4.6. Chọn số mặt  cắt  xuất  nội lực cho dầm Output Station. 
• Chọn toàn bộ dầm. 

Để chọn nhanh dầm làm như sau :Select > Properties > Frame Sections… 
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• Chọn toàn bộ dầm trong danh sách. 

 

Hình 4-22 Chọn từ danh sách dầm. 

• Asign >Output Station… 
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Hình 4-23 Asign Frame Output Station. 

4.7. Chia sàn tự động AutoMesh. 
• Chọn toàn bộ sàn. 

Để chọn nhanh sàn : Select >Properties >Area Section… 
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• Chọn toàn bộ sàn trong danh sách. 

•  

Hình 4-24 Select Sections. 

• Assign > Area > Automatic Area Mesh… 
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Hình 4-25 Assign Automatic Area Mesh. 
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BÀI 5 :  ĐỊNH NGHĨA CÁC PHƯƠNG ÁN TẢI  – GÁN TẢI  TRỌNG CHI 
TIẾT. 

5.1. ĐỊNH NGHĨA LOAD PATTERN. 

 
• Define > Load Pattern… 

Khi chúng ta bắt đầu một mô hình mới ,SAP 2000 tự động tạo Load Pattern DEAD để 

gán cho tải trọng bản thân. 
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Hình 5-1 Define Load Pattern 

• Load Pattern Name : Tên loại tải 
Sửa Load Pattern Name thành TTBT(tải trọng bản thân) 

• Type : Dạng tải (chỉ để xác định hệ số tổ hợp khi SAP 2000 tự tổ hợp). 

• Self  Weight Multiplier : Hệ số kể đến tải trọng bản thân( chỉ có tải trọng bản thân 
type Dead có hệ số khác 0 còn lại là bằng 0) 

• Auto Lateral Load Pattern : Khai báo tải trọng ngang 

• Add New Load Pattern : thêm loại tải 

• Modify Load Pattern : Sửa loại tải 

• Delete Load Pattern : Xóa tải 

• Ok 

5.2. Định nghĩa các phương án chất tải  và kiểu phân tích  Load Case 
Bản thân Load Pattern chưa tạo bất kì tác động nào (biến dạng,ứng suất,….)đến hệ kết 

cấu.Load Case phải được định nghĩa để gán tải lên hệ. 

• Define Load Case… 
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Hình 5-2 Define Load Case. 

Mỗi khi khai báo một Load Pattern chương trình sẽ tự động khai báo một Load Case 

tương ứng cùng tên phân tích tĩnh tuyến tính. 

Nhấn Modify/Show Load Case…  để điều chỉnh  

 

Hình 5-3 Modify/Show Load Case 
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5.2.1. Phân t ích tĩnh và động lực học. 

a. Static : Phân tích tĩnh 
Một phân tích tĩnh được giả thiết rằng chỉ có lực liên quan đến độ cứng là quan trọng. 
Nếu tải là hằng số trong một khoảng thời gian tương đối dài thì chọn phân tích tĩnh còn 

không chọn phân tích động lực học Modal 
Thông thường  nếu tần số kích thích nhỏ hơn 1/3 tần số riêng nhỏ nhất của kết cấu thì có 

thể chấp nhận phân tích tĩnh. 

b. Modal : Phân tích động lực học. 

Phân tích chu kì dao động và dạng dao động. 
Thường sẽ phải tính đến lực quán tính và lực cản nếu tải áp đặt thay đổi theo thời 
gian.Vì vậy có thể dùng tính chất phụ thuộc thời gian của tải để chọn giữa phân tích tĩnh 
và phân tích động. 

5.2.2. Phân t ích tuyến tính và phi tuyến. 

 

Hình 5-4 Analysis Type. 

a. Phân tích tuyến tính Linear. 

Một phân tích tuyến tính với giả thiết rằng tải áp đặt vào làm thay đổi không đáng kể 
đến độ cứng của kết cấu .Các dấu hiệu điển hình : 

• Chuyển vị nhỏ ; 
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• Biến dạng và ứng suất nằm trong miền đàn hồi. 

• Tiếp xúc giữa hai vật thể. 

b. Phân tích phi tuyến Nonlinear. 

Một phân tích phi tuyến là cần thiết nếu tải trọng làm thay đổi độ cứng của kết cấu.Các 
nguyên nhân cơ bản dẫn đến sự thay đổi độ cứng của kết cấu : 

• Biến dạng ra khỏi vùng đàn hồi; 

• Chuyển vị lớn ,ví dụ như tải áp đặt trên đỉnh tháp viễn thông. 

• Tiếp xúc giữa hai vật thể. 

5.3. Định nghĩa tổ hợp tải trọng Load Combination. 
• Define > Load Combination 

 

Hình 5-5 Hộp thoại Add New Combo 



SAP 200 V14.0.0 – Công cụ cơ bản 

Ks.Lê Văn Duy SĐT : 0916028581 

Trung tâm đồ họa Hoàng Nhi.                                                                                       70 

 

Hình 5-6 Hộp thoại Load Combination Data. 

Ví dụ : 
Chuyển vị tính toán được do TT là 3.5 

Chuyển vị tính toán được do tải trọng động đất EQ là 2.0 

ADDCOMBO : Lớn nhất = 3.5+2.0=5.5 

  Nhỏ nhất  = 3.5-2.0=1.5 

ENVECOMBO : Lớn nhất = Max(3.5;2.0)=3.5 

  Nhỏ nhất =Min(3.5;2.0)=2.0     

5.4. Gán tải chi tiết cho các phương án tải đã định nghĩa : 
SAP 2000 quan điểm một phương án chất tải được phân loại thành tải trọng vào nút và 

tải trọng vào phần tử. 

5.4.1. Tải trọng vào nút. 

a. Tải trọng tập trung nút. 

• Mét nót cã 6 tp=  Fx,y,z; Mx,y,z. DÊu Fx,y,z= trôc, Mx,y,z=  ng­î c chiÒu kim ®ång 
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hå. 
• Khai b¸ o 

• Chän nót 

 
 

Hình 5-7 Asign Joint Load 

• NhËp c¸ c gi¸  trÞ lùc vµ m«men tËp trung theo c¸ c ph­¬ng, chó ý dÊu cña t¶i 
träng 

 
Hình 5-8 Gán phương và độ lớn tải trọng 
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b. Xem tải trọng:  

 
• NÕu lùc tËp trung ®Æt trï ng ph­¬ng ví i ®iÒu kiÖn biªn cña nót th× chØ  g©y ra ph¶n 

lùc nót. 

c. Chuyển vị cưỡng bức (Joint Displacement) 

• Mét nót cã 6 tp. 3tp=  Ux,y,z; 3tp= Rx,y,z. DÊu U= trôc, R=  ng­î c chiÒu kim ®ång 
hå. § ¬n vÞ: U= chiÒu dµi, R= Radian 

Khai b¸ o 

• Chän nót 

 
• NhËp gi¸  trÞ chuyÓn vÞ c­ì ng bøc. 
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Hình 5-9 Gán chuyển vị nền. 

 
 
 
 

5.4.2. Tải trọng trên thanh. 

 

Hình 5-10 Những loại tải thường gặp 

• Trong mçi mét tr­êng hî p t¶i träng th× mét Frame cã thÓ g¸ n c¸ c d¹ ng t¶i träng: 
Uniform: ®Òu, Trapezoidal: H×nh thang, Point Load: TËp trung, T¶i träng träng 
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lùc(Gravity, th­êng kh«ng dï ng). 
• ë ®©y ®ang xÐt cho mét tr­êng hî p t¶i träng nªn trong qu¸  tr×nh khai b¸ o lùa chän 

Load Case Name (Tªn tr­êng hî p t¶i träng) mÆc ®Þnh chän tr­êng hî p t¶i träng 
cã tªn lµ Load1. Sau nµy khi g¸ n cho tr­êng hî p t¶i träng kh¸ c th× nhÊt thiÕt ®Çu 
tiªn ph¶i chän tªn tr­êng hî p t¶i träng cÇn g¸ n. 

a. Uniform load (Span Load) 

• Chän Frame 

 
• NhËp « Uniform Load 
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b. Xem tải trọng trên thanh. 

 

a. Tải trọng tập trung trên thanh. 

• Sè ®iÓm ®Æt t¶i tËp trung lµ kh«ng h¹ n chÕ tuy nhiªn mçi lÇn g¸ n nhiÒu nhÊt chØ cã 
4 ®iÓm ®̈ t t¶i tËp trung (1 ®iÓm ®Æt t¶i tËp trung cã thÓ cã nhiÒu thµnh phÇn lùc 
tËp trung theo c¸ c ph­¬ng vµ kh¸ c nhau) 

Khai b¸ o: 

• Chän Frame 
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• Gán phương và độ lớn tải : 
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b. Tải trọng phân bố không đều.  
B¶n chÊt lµ t¶i träng ph©n bè cã gi¸  trÞ thay ®æi. Sè ®iÓm thay ®æi kh«ng h¹n 

chÕ. Nh­ng mçi lÇn g¸n chØ cho phÐp khai b¸o bèn ®iÓm thay ®æi. 
Khai b¸ o: 

• Chän Frame 

 
 Nhập vị trí ở hàng Distance và độ lớn ở hàng Load 
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SAP 2000 bỏ qua những ô có giá trị khoảng cách nhỏ hơn khoảng cách ở các ô trước 

đó. 



SAP 200 V14.0.0 – Công cụ cơ bản 

Ks.Lê Văn Duy SĐT : 0916028581 

Trung tâm đồ họa Hoàng Nhi.                                                                                       79 

Bảng 5-1 Ví dụ tải trọng phân bố không đều. 

 

5.4.3. Tải trọng trên tấm. 

a. Tải trọng phân bố trên tấm 
T¶i träng  ph©n bè theo ph­¬ng bÊt kú. SÏ  ®Æt t¹ i mÆt ph¼ng trung b×nh cña tÊm 
Khai b¸ o 

• Chän Shell 
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• NÕu t¶i träng vu«ng gãc ví i mÆt ph¼ng trung b×nh cña tÊm th× chän Direction 

lµ trôc 3 trong c¸ c bµi to¸ n phøc t¹ p nh­ bÓ trô trßn xoay. 
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BÀI 6 : GỐI TỰA VÀ MỘT SỐ KHAI BÁO KHÁC. 

6.1. Gán – điều chỉnh gối tựa lý tưởng. 
Thông thường khi sinh ra kết cấu,SAP đã gán luôn gối tựa cố định. 

• Bước 1 : Xuống cao độ Base chọn toàn bộ nút. 

• Bước 2 : Vào Assign > Joint…> Restrains. 

 

Hình 6-1 Cửa sổ Joint Restraints. 

• Quay gối : 
Các gối lý tưởng  mặc định theo chiều của hệ tọa độ tổng thể thẳng đứng,trong thực tiễn 
gối có vị trí bất kì.Điều chỉnh gối như sau : 

o Bước 1 : Chọn gối cần quay 
o Bước 2 : Asign > Joint  > Local Axes > Vào góc quay theo trục. 

6.2. Gán điều chỉnh các gối tựa lò xo 

§ é cøng kh¸ c v« cï ng khi ®ã t¹ i li ªn kÕt cã chuyÓn vÞ kh¸ c 0 

• Bước 1 : Chän nót 
• Bước 2 : Assign > Joint > Spring  

• Translation 1,2,3= K(X,Y,Z)= NhËp gi¸  trÞ Lùc/chiÒu dµi.  
• Rotation 1,2,3= Kr(X,Y,Z)= NhËp gi¸  trÞ Moment/Rad.  

• Th­êng c¸ c bµi to¸ n kÕt cÊu kh«ng ph¶i nhËp gi¸  trÞ Rotation. Gi¸  trÞ Translation 
cã thÓ hiÓu lµ ®é cøng lß xo cña gèi tùa theo c¸ c ph¬ng t¬ng øng. 

• Sö dông tèt trong bµi to¸ n trªn nÒn ®µn håi. 
• Add: Céng ®¹ i sè 
• Replace: Thay toµn bé gi¸  trÞ mí i 
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• Delete: Xo¸  toµn bé gi¸  trÞ ®·  g¸n. 

6.3. Quay hệ tọa độ cục bộ của thanh và tấm. 

6.3.1. Quay hệ tọa độ cục bộ của thanh 

 

Hình 6-2 Xoay hệ tọa độ của thanh. 

Dùng để quay tiết diện hoặc đổi chiều của hệ cục bộ 

• Chọn thanh  cần điều chỉnh 

• Assign > Frame > Local Axes 

 

Hình 6-4 Frame Local Axis 

6.3.2. Quay hệ tọa độ của tấm. 
 
Dùng để đổi chiều của hệ địa phương hoặc quay hệ địa 

phương một góc  

• Chọn tấm cần điều chỉnh 

• Assign > Area > Local Axes  

Hình 6-3 Xoay tấm. 
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Hình 6-5 Area Local Axis. 

6.4. Vào các l iên kết đặc biệt 2 đầu thanh( giải phóng thành phần lực) 
• Mặc định là các thanh 2 đầu nút cứng (continous) hoặc 2 đầu khớp (pinned) 

• Chọn thanh  

• Assign > Frame > Frame Release/Partial Fixity > giải phóng thành phần lực nào 
thì nhấn vào box tương ứng; và  ứng với nút đầu (start) hoặc nút cuối 
(end).Thường là giải phóng M3=0 

• Nếu muốn loại bỏ khớp : làm tương tự nhưng chọn ngược lại. 

 

Hình 6-6 Assign Frame Releases 

6.5. Điều chỉnh nhịp tính toán. 
• Muốn SAP 2000 báo cáo kết quả nội lực tại mép kết cấu(nhịp thông thủy –tức là 

kết quả sẽ sát thực hơn; lợi cho bố trí cốt thép) 
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• End offset : giảm chiều dài tính toán của thanh bằng cách trừ đi vùng giao nhau 
của các frame tại nút…Mặc định SAP 2000 không xét EndOffset. 

• Nếu xét đến EndOffset khi đó chiều dài tính toán được tính bằng hệ số Lf 

 

Hình 6-7 Frame Offset 

Lc=L-(Ioff+Joff) 
Lf= L-Rigid(Ioff+Joff) 
L = chiều dài của Frame tính theo nút 
Lc= chiều dài thông thủy của frame 
Ioff và Joff : chiều dài vùng cứng tại đầu I và J của Frame 
Rigid : Hệ số giảm vùng cứng. 
Sap = 0.5 
Lf= Chiều dài tính toán của Frame khi xét đến EndOffset 

• Chọn thanh  

• Assign > Frame > EndOffset 
• Chế độ Auto là ngầm định tự động sẽ báo cáo tại mép. 
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Hình 6-8 Frame End Length Offsets 

6.6. Điều chỉnh số mặt cắt tính toán. 
• Chọn thanh 

• Assign > Frame > Output Station 

 

Hình 6-9 Output Station 

 

6.7. Tự động chia thanh (Automatic Mesh Frame). 
 

• Chọn thanh. 
 

• Assign > Frame > Automatic Frame Mesh… 
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Hình 6-10 Automa tic Frame Mesh. 

 

Hình 6-11 Assign Automatic Frame Mesh. 
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Hình 6-12 No Automatic Meshing. 

 

Hình 6-13 Auto Mesh Frame.  
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BÀI 7 : ĐỌC KẾT QUẢ NỘI LỰC THANH – TẤM – IN 

7.1. Đọc kết quả bằng đồ họa 

• Sö dông chñ yÕu:  toolbar 
• Deformed shape: S¬ ®å biÕn d¹ng 
• Reaction vµ Spring Force 
• F: Frame: Chän lo¹ i néi lùc (Axial, Shear, Moment..) 
 

 
 

• S: Shell: øng suÊt hoÆc Néi lùc (Ph©n bè trªn chiÒu dµi) 
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7.1.1. Xem chuyển vị (Displacement) 
• Display > Show Deformed Shape… 

Click  Set Default 3D View để xem biến dạng trong không gian 3D 
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Để xem 3D nâng cao có thể vào View > Set 3D View 

          
 

a. Xem hoạt hình 
• Biến dạng có thể xuất dưới dạng hoạt hình bằng cách click vào Start Animation 

 
• Tốc độ hoạt hình có thể điều chỉnh bằng mũi tên 

b. Xuất  Video 

• File > Creat Video > Creat Cyclic Animation Video… 
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Hình 7-1 Hộp thoại Animation Video File Creation. 

7.1.2. Xem nội lực thanh. 
• Display > Show Forces/Stresses > Frame/Cables 
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Hình 7-2 Member Force Diagram 

• Có thể xem nội lực của từng thanh bằng cách click chuột phải vào thanh. 
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Hình 7-3 Diagrám For Frame Object. 

7.1.3. Xem phản lực React ion. 

• Display > Show For ces/Str esses > Joints… 
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Hình 7-4 Joint Reaction Forces. 

• Có thể xem nội lực chi tiết của từng nút bằng cách click chuột phải vào nút 



SAP 200 V14.0.0 – Công cụ cơ bản 

Ks.Lê Văn Duy SĐT : 0916028581 

Trung tâm đồ họa Hoàng Nhi.                                                                                       96 

 

Hình 7-5 Joint Reaction 

7.2. Xem kết quả phân tích dạng bảng. 
• Display > Show Tables… 
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Hình 7-6 Choose Table for Display 

• Chọn xem kết quả bằng drop-down. 
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Hình 7-7 Element Forces-Frames. 

7.3. In kết  quả t ính toán 

• Sö dông file * .out (File in toµn bé phÇn tö) 
• Menu File\Print  Output Table (Print to file): Th­êng dï ng ®Ó in  mét sè phÇn 

tö. Th­êng in dÇm riªng, cét riªng. 
• Lùa chän phÇn tö, nªn dï ng menu select chän section. 
• Menu File chän Print output table  
• Chän Print to file 
• Chän Selection Only 
• Chän Spread Format 
• Chän file name, chän file type * .* , nhËp tªn file <name>.xls, bÊm save(open) 
• Chän c¸ c kiÓu in kÕt qu¶ (Displacment, Frame force, Shell Force, Reaction) 

chän tr­êng hî p t¶i t­¬ng øng. 
• BÊm OK 

ð  Më file võa Output trong Excel, vµ dï ng Excel ®äc kÕt qu¶. 
ð  Dï ng c¸ c kiÓu läc vµ S¾p xÕp trong Excel ®Ó ®äc kÕt qu¶ cho nhanh: Data 

Filter, Sort… 
• Cã thÓ in tõng lo¹ i ®èi t­î ng, t¶i träng… 
• In file d­í i d¹ng c¬ së d÷ liÖu (MDB Access): Nªn dï ng 
• In ®å ho¹ 
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• Chó ý in: NÕu in b»ng Lazer HP chän HPIII hoÆc HP6L PCL 
• C¾t ®å ho¹  vµo word: 

• ChuyÓn mµn h×nh sap vÒ mét cöa sæ (ChuyÓn mµu mµn h×nh) (Menu Option). 
• BÊm phÝm Print Screen. 
• Më Microsoft Foto editor (Paint) 
• Menu Edit\Paste as new Image 
• Select 
• Menu Image\Crop ->Ok 
• Menu Edite -> Select All 
• Copy 

-  Word: Edit-> Paste Special-> Picture (tiÕt kiÖm bé nhí ) 
 
 

 



SAP 200 V14.0.0 – Công cụ cơ bản 

Ks.Lê Văn Duy SĐT : 0916028581 

Trung tâm đồ họa Hoàng Nhi.                                                                                       100 

BÀI 8 : THIẾT KẾ KẾT CẤU. 

8.1. Chọn tiêu chuẩn thiết kế 

• Design > Concrete Frame Design > View/Revise Preferences… 
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Hình 8-1 Chọn tiêu chuẩn thiết kế. 

8.2. Chọn tổ hợp thi ết  kế. 
• Thiết kê cột dùng tất cả các tổ hợp ngoài tổ hợp bao 

• Thiết kế dầm chỉ dùng tổ hợp bao 

• Design > Concrete Frame Design > Select Design Combos… 
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Hình 8-2 Chọn tổ hợp thiết kế dầm. 

8.3. Chạy thiết  kế. 

• Design > Concrete Frame Design > Start Design/Check of Structure… 

•  

8.4. Hi ển thị kết quả thiết kế. 
• Design > Concrete Frame Design > Display Design Info… 
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• Có thể xem chi tiết kết quả thép của thanh bằng cách click chuột phải vào thanh. 

 

Hình 8-3 Kết quả thiết kế chi tiết cột bê tông cốt thép. 
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PHỤ LỤC : HƯỚNG DẪN CÀI ĐẶT. 
 
Bước 1 : Copy hai file SAP2000_V14_DVD.zip (file cài đặt) và 

SAP2000_V14_Patcher_R2_By_eng_ghost.rar (file Crack)  vào máy tính. 
Lưu ý : không copy vào ổ C để tránh mất mát do lỗi Windows hoặc phần mềm đóng 

băng ổ cứng. 
Bước 2 : Giải nén hai file trên :  
-Click chuột phải và chọn Extract Here. 

 

Hình 0-1 Hướng dẫn giải nén file. 

Bước 3 : Cài đặt chương trình . 
-Click đúp vào file Autorun. 

 
• Click vào Install SAP2000 V14….. 
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Chọn Install của Standalone Installation. 

 
-Click nút Next 

 
Chọn I Acept… và nhấn Next 
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• Khai báo tên người dùng và cơ quan công tác sau đó nhấn Next 

 
Next,Next rồi nhấn Install đợi ít phút cho đến lúc Finish. 
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Bước 4 :  Crack phần mềm. 
-Copy file  vào folder cài đặt Sap 2000 
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Tìm folder cài đặt Sap 2000 bằng cách click chuột phải vào biểu tượng Sap 2000 chọn 
Properties 

 
Nhấn Find Target ( hoặc File Location Folder) để tìm folder cài đặt 
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Nhấn Ctrl + V để dán file crack 
 


